1. Intro ..........................................................................................................................................................................................3
  1.1. Terminology ..................................................................................................................................................................................3
  1.2. Manual Workflow (DFS only) .........................................................................................................................................................4
  1.3. Automatic workflow (using AE) ....................................................................................................................................................5
  1.4. Semi-Automatic Workflow (manual intervention) ..........................................................................................................................6
  1.5. Introducing CDI related Views and Tasks ....................................................................................................................................7
  1.6. Main Steps in Setting Up this Workflow ......................................................................................................................................8
  1.7. Reporting to Business Systems ....................................................................................................................................................9
  1.8. Removed CDI Related Tools ...........................................................................................................................................................9

2. CDI Related Views .............................................................................................................................................................................10
  2.1. Devices (CDI) ...................................................................................................................................................................................10
    2.1.1. CDI Device Status in an External Dashboard ...............................................................................................................................11
  2.2. Press Plates ....................................................................................................................................................................................14
  2.3. Press Plate Sets ................................................................................................................................................................................17
  2.4. Plate Merger ...................................................................................................................................................................................19
    2.4.1. Adding a Merge Queue ...............................................................................................................................................................20
    2.4.2. Managing Merge Queues ...........................................................................................................................................................24
    2.4.3. Plate Merger Configuration ........................................................................................................................................................26
    2.4.4. Working with Layout Proposals .................................................................................................................................................34
  2.5. Merged Plates ................................................................................................................................................................................44
  2.6. CTP Queues ...................................................................................................................................................................................49

3. CDI and LEN related Tasks .................................................................................................................................................................52
  3.1. Add Margins to LEN file task .........................................................................................................................................................52
  3.2. Crop LEN File task ...........................................................................................................................................................................53
  3.3. Submit to Plate Merger task ..............................................................................................................................................................54
  3.4. Create Merged Plate task .................................................................................................................................................................58
  3.5. Submit to Flexo CTP Device task ..................................................................................................................................................58

4. Using the DFS Merger in AE mode .................................................................................................................................................60
  4.1. Creating the SmartName for the CDI Job Name ..............................................................................................................................63

5. FAQs ........................................................................................................................................................................................................65

6. XML technical details ............................................................................................................................................................................66
  6.1. Interpreting reporting XMLs ............................................................................................................................................................66
Automation Engine offers a range of tools that help automate platemaking on a CDI. Using these tools brings these benefits:

- A view on the CDI device within the Pilot, including its job load and queue management.
- Automatic merging of LEN files onto a CDI plate.
- Detailed feedback from the CDI about the exposed plates, including waste factors.
- Easy monitoring of status of a plates of a specific job, even when spread over several CDI plates or merged with separations from other jobs.
- Easy remaking of CDI plates (full or partial).

### 1.1. Terminology

While learning about the involved tools, it is important to understand the used terminology, especially the terms **Press Plate** and **Merged Plate**.

- **CDI**: Cyrel Digital Imager, Esko’s digital flexo plate imager. Learn more [on this web page](#).
- **DFS**: Digital Flexo Suite. A set of interactive applications to manually prepare LEN files and expose them on a CDI. Learn more [on this web page](#).
- **DFS Merger**: The Merger is one of the applications of the DFS. An operator uses it to prepare LEN files, merge them onto a layout, create a LEN file of that layout and send it to the queue of the **DFS Exposer**.

One DFS Merger can drive several CDIs, unless it is installed on the PC of the CDI itself (in which case it is called ‘Grapholas Merger’).

- **LEN file**: RIP output format that can be imaged on a CDI. Esko Imaging Engine or FlexRip/C can create LEN files.
- **Merging**: Placing LEN files next to each other on a same layout, typically as many as possible, to avoid wasting plate material.

- **“Press Plate”**: A RIP’ed separation (LEN file) that can be merged before being imaged on a CDI.
The term "press" emphasizes that this a plate in the view of a printer: even when several are merged with other Press Plates onto a CDI plate, they will be split/cut again after imaging and processing, so that every Press Plate can end up as one plate on the press.

On the DFS, this is called an "image". The terminology in the DFS applications is focussed purely on the CDI (not on the whole workflow up to the printer).

On Automation Engine, a LEN file becomes a Press Plate the moment it was submitted to the Plate Merger.

A "Press Plate Set" is a group of press plates that belongs to the same job.

• "Merged Plate": A LEN file on which several Press Plates were merged. A Merged Plate can contain several separations of a same job or even separations from other jobs. After imaging and processing, a Merged Plate will be cut to end up with several plates for the printer.

On the DFS, this is called a "Plate", because this is one plate when being imaged on the CDI.

• Kongsberg: Esko Kongsberg cutting tables are typically used for their precision and productivity in cutting for example plates with staggered cuts or PlatePatcher layouts.

1.2. Manual Workflow (DFS only)

This page first illustrates the manual workflow where DFS uses local LEN files to make the Merged Plates.

These are the main process steps:

1. LEN files are written into the “working folder” of the DFS station. These files can be created by an Imaging Engine or FlexRip, or could have arrived from a remote site.

2. The DFS Merger operator
   • selects the CDI and plate type that the layout will be exposed on. He then selects the LEN files ("images") from that "working folder" and loads them into the Merger.
   • He then manually creates a layout for the selected CDI plate and/or uses the "Auto Arrange" feature to get some help with that.
   • He can use interactive editing functions like crop, cut, rotate etc.

3. When a final layout is made for that CDI, he presses "Expose!" to send it to the CDI’s expose queue (the Exposer application).
4. The CDI operator mounts a flexo plate on the CDI and uses the Exposer application to start the exposure.
5. After exposure, the plate goes through its post processing steps and may be cut before being sent to the press room or shipped to the printer.
6. DFS also writes HTML files containing the history of the exposed plates and their plate usage. These can be used by an external system for job status or production statistics.

1.3. Automatic workflow (using AE)

In this workflow, Automation Engine replaces the use of a DFS Merger and provides extra tools to view the history of this output.

1. LEN files arrive in Automation Engine from a local Imaging Engine or FlexRip or from external RIPs or systems.
2. Editing LEN files can be automated using the Add Margins and Crop tasks.
3. LEN files are submitted to a specific queue of the Plate Merger, together with parameters setting some merging criteria or due date. A Merge Queue typically represents a plate type and can offer several sizes of that plate type.

**Note:** You can also configure that test strips or margins need to be added to the layout.

4. When the Merge Queue decided on a layout, it starts a workflow that creates the Merged Plate LEN file and then submits that file to the CDI’s expose queue.

**Note:** In this workflow, creating the Merged Plate LEN file is a task on your Automation Engine server and not on the standalone DFS computer.

5. The CDI operator uses the Exposer application to expose the Merged Plate.

**Note:** When so configured in the Plate merger Configuration, any successful imaging of a CDI plate automatically triggers a workflow that submits the related cutting XML file to the Kongsberg’s iPC. Learn more here.

6. In the Pilot, some extra views support this workflow:
   - The Merged Plates view shows all Merged Plates, in their different states. In this view you can also easily resubmit plates back to the CDI queue, typically in cases where you need
to remake them. You can choose to resubmit the whole merged plate or only selected press plates.

- The **Press Plates** view helps you to overview which LEN separations are or have been part of this workflow.

- The **Press Plate Sets** view adds an extra job order perspective.

7. Reporting back to business systems. This workflow can also automatically send reports about the device or the job order to external systems. Learn more in *Reporting to Business Systems* on page 9.

### 1.4. Semi-Automatic Workflow (manual intervention)

Even when you use the tools in Automation Engine, you can still use the DFS Merger to manually intervene. Some examples:

- When you want to use one of the partial flexo plates available in the plate room. Learn more in *Plate Merger* on page 19.

- When you want to optimize plate usage by adding (smaller) Press Plates (“Images”) that only recently arrived in the queue and have a lower priority.

**Note:** This manual intervention to optimize the plate usage can sometimes be replaced by using the option to *reconsider* already merged plates: this puts all its press plates back into the automatic merger and so makes them re-merge with any (small) new arrivals in that queue.

In the following cases, merging cannot be done by using the tools within Automation Engine. It has to be done with the manual DFS Merger application, using local LEN files:

- In a DFS PlatePatcher workflow (corrugated).
- To manually crop LEN files.

**Workflow steps:**
1. When using the DFS Merger in AE Manual mode, the DFS user first selects one of the existing Plate Merger queues on Automation Engine. To prevent any conflicts, the selected merge queue is automatically paused.

2. The DFS user loads the Press Plates ("Images") that are present in the selected merge queue and manually creates a layout with (some of) those.

3. When finished, the DFS user clicks "Expose". This automatically makes Automation Engine launch the workflow that was defined for that merge queue. From this point on, the workflow is identical as when working fully automatic: a merged plate LEN file is made from that layout and is then sent to the CDI expose queue.

**Attention:** Limitations in the DFS Merger when in AE manual mode:
- It is not possible to manually Crop the LEN files in the DFS Merger when it is set in AE Manual mode. Consider using Automation Engine's Crop LEN File task.
- You cannot use the Viewer in DFS/PlatePrep to view the LEN files. Use the Automation Engine Viewer instead.
- Whether a LEN file is allowed to be rotated or not is controlled by the merge queue setting and/or by the value set for 'Rotation' in the 'Submit to Plate Merger' task. If rotation is not allowed, the rotation button in the DFS Merger application will be greyed out.

### 1.5. Introducing CDI related Views and Tasks

Automated platemaking on a CDI is enabled by dedicated tasks and Pilot Views. Find their detailed documentation in CDI Related Views and CDI and LEN related tasks. Here's an overview:

**Views and Tools**

- 🛢 **Devices.** This view shows an overview of your configured CDIs (and Kongsberg tables). It shows their machine status and the amount of CDI plates in their expose queue.

**Note:** This View can also be opened as a separate window next to the Pilot.

- 📜 **Plate Merger.** This view is where you configure and monitor Merge Queues. A merge queue calculates layouts of press plates (RIP'ed separations) onto a merged plate (CDI plate layout).

**Note:** This View can also be opened as a separate window next to the Pilot.

- 📄 **CTP Queues.** This view shows the device queues in a graphical way. You see details about their queue items and you can manage them (delete, change order, resubmit or, when possible, move to another queue).

- 📌 **Press Plates.** This view lists details about all press plates that were submitted to the plate merger. It offers smart filtering, viewing and easy navigation to the job they belong to or to the merged plate they are/were part of. You can also resubmit press plates back to the plate merger.

- 📋 **Press Plate Sets.** This view shows the press plates in a job order context. It for example allows a CSR (Customer Service Representative) to monitor all jobs needing CDI press plates and see how many have been imaged yet.
• **Merged Plates.** This view lists details about all merged plates. You can select one and resubmit all its press plates back to the plate merger, typically when you think you can (now) get a more optimized layout. Double click them to zoom in and see a large preview of their layout and details about their press plates, of which you can also resubmit a selection back to the plate merger.

**Tasks**

• **Add Margins to LEN file task.** Use this task to make sure there is enough room between press plates on a merged plate. Alternatively, this can be also be done by adding *Press Plate Margins* in the merge queue.

• **Crop LEN file task.** Use this task to crop LEN files to the first image pixel or to the staggered cut line.

• **Submit to Plate Merger task.** Use this task to submit LEN files (press plates) to the plate merger.

• **Create Merged Plate task.** When the plate merger decides on a layout, it uses this task to create the LEN file of that layout.

• **Submit to CDI task.** This task submits the LEN file of the merged plate to a CDI expose queue.

### 1.6. Main Steps in Setting Up this Workflow

Once you have a working setup of DFS (or Grapholas) software, then these are the main steps to set up this workflow in the Pilot:

1. **Create one or more Devices.** In the *Devices* View, click 🔄 to add a device for every CDI you have.

2. **Create Plate Merger queues.** In the *Plate Merger*, click ✉️ to add a merge queue for every type of flexo plate that you use on any of the configured CDIs. You can pick them from the list of plate types that is automatically retrieved from the configured CDIs. Also set the merge settings for every queue.

   **Tip:** When you have more than one CDI, it is not necessary to make a specific merge queue for each CDI. This would prevent the load balancing: it could then not decide to make the plate for the least busy device.

3. **Create an output workflow for the merge queue(s).** In the Tickets view, create a workflow that starts with creating the Merged Plate LEN file and ends with submitting that file to a CDI expose queue.

   **Caution:** When adding more steps to this workflow, make sure to still respect the required input files for both these mandatory task steps. Learn more in *these notes on Output Workflows*. 

4. **Attach the workflow to the merge queue(s).** Complete the setup of the merge queue(s) by adding the output workflow that you created in the previous step.

5. **Test.** Select a group of LEN files, open a *Submit to Plate Merger* task, select the right plate type and launch the task. When the fill rate is too small, use "**Force Out**" to see the next steps in the workflow. You should see a new entry in the CDI expose queue.

6. **Adapt your existing RIP workflows** by adding a *Submit to Plate Merger* task at their end. The tools used in this workflow are described in detail in the pages on the [Views](#) and [Tasks](#).

### 1.7. Reporting to Business Systems

When making digital plates, this type of information is often asked for:

- Statistics on plate usage: type, waste, etc.
- Statistics on a CDI device: Till when is this CDI planned to be busy? How much time has it been exposing this week and at what resolution?
- Job order information: Are all press plates for this job exposed on the CDI yet? What is the plate usage/waste for this job?

All this information can be sent to any external system by workflows that are automatically launched at specific events in a CDI workflow. Learn more in *Plate Merger Configuration* on page 26.

This information can be delivered via XML files, web [service calls](#), or even direct [database interaction](#). Learn more about such integration techniques in the chapter *Integrating with External Systems.*

### 1.8. Removed CDI Related Tools

In Automation Engine 14, the "CDI View" and the "Make Plate on CDI task" enabled a minimal connection to a CDI.

These tools were removed in AE v16 when the new tools became available.
2. CDI Related Views

These tools and tasks and their concepts were introduced *in this intro.*

2.1. Devices (CDI)

| Tip: | The Devices View can also be opened as a Tool: Go to **Tools > Devices** to monitor and manage your devices in a separate window. |

**Adding a CDI Device**

Follow these steps to add a CDI device:

1. In Devices View, click on ` устройства`. 
2. Select the category **CDI Imagers**.
3. A list is shown with CDI's (computers with Grapholas software) that were found in the same network domain as your Automation Engine server. Select the one you want.

Alternatively, click **Add Other** to add a **Server** name yourself (or type its IP address). This may for example be needed when the CDI computer is in a sub-domain.

**Attention:** The computer that drives the CDI must be configured to use a fixed IP address. This can be achieved by either setting a fixed IP address on this computer or preserve a fixed IP address on the DHCP server.

4. Click **Add** to confirm. The status box of the newly created device appears.

**Note:** Older CDI devices show up in a lighter blue color.

**Note:** Adding a CDI device requires a license per device.

**Information and functionality**

The device status box shows following information that it gets directly from the Exposer application of that CDI:

- The **name of the device.** By default this is the name of the computer where the DFS or Grapholas software was detected. Open the **Info** panel to change it to a custom name.
• The **amount of merged plates in the expose queue**. This is the amount of jobs in its expose queue (exposing and waiting).

• A **device status icon.**
  - ![Retrieving the status](image)
  - ![The device is offline. There is no connection with the device's computer (switched off, network problem, etc.).](image)
  - ![The device is online. It could be idle or busy imaging.](image)

• The **Estimated time** when the current job load will be finished (how long the CDI is scheduled to be busy).

**Attention:** CDI's with a Grapholab version 12 up to v14.0 cannot feed a correct estimation of the exposing time to Automation Engine. Therefore, in this view, you will not see this information for these older devices.

Right-click a status box to choose one of these options:

• **Info** (or press `I`). This dialog shows details about the device (version, settings, etc.). You can add a **Description** to illustrate or help identify this device. Click **Advanced Options** for a detailed technical list of its parameters.

• **Delete** (or press `Delete`). You will be asked to confirm.

• **New Device**. An alternative to clicking `N`.

### 2.1.1. CDI Device Status in an External Dashboard

**Concept**

Some customers are using a dashboard where they monitor their company's activity. This dashboard can be a part of their business system or it can be custom-built. These sites often also want to see the status of their CDI devices in that same interface.

**Note:** To get detailed information about specific plate consumption and job status, learn more in Tab 'Reporting' on page 28.

The external system that shows the dashboard can ask Automation Engine for the CDI status via HTTP GET calls. It can so collect the same information that you can see in the **CDI Device View**:

• **General** device status (idle or exposing).

• The **amount of merged plates in the expose queue**. This is the amount of jobs in its expose queue (exposing and waiting).

• The **estimated time** when the current job load will be finished (how long the CDI is scheduled to be busy).

Regular updates of the status of all CDI queues can be retrieved via **Server-Sent Events (SSE)**.

**Syntax**

• Getting the status of a specific CDI:
• In a browser, go to `<name-of-AE-server>:4412/FPL/cdi/<name-of-CDI-device>`.

  An example:

  ![XML file example]

  • Continuously getting the status of all CDI's via Server-Sent Events (SSE):

    • In a browser, go to `<name-of-AE-server>:44111/CDI`. You will first see an info page. In there, click the link to the Server-Sent Events to see the live status of all CDI's.

    • Per CDI device, the following information is returned:

      • **NAME**: Name of the machine.
      • **IP**: IP-address of the machine.
      • **STATE: OFFLINE**: When the machine cannot be reached.
      • **IDLE: TRUE**: When the machine is not exposing.
      • **IDLE: FALSE**: When the machine is exposing.
      • **QUEUELENGTH**: Number of entries in the expose queue.
      • **TIME**: The time in seconds to empty the queue (on condition of continuously exposing from now onwards).

  An example:
Ask your browser to view the source of this web page. This will reveal the JavaScript that translates the incoming events to the readable table.

An example (in the browser 'Chrome'):
2.2. Press Plates

**Note:** The terms "Press Plates" and "Merged Plates" were introduced in the page on Terminology on page 3.

### Concept

This view lists all the Press Plates in rows. Select one to see a preview and some key information in a pane on the right.

When your Pilot is in a Job mode, you only see the press plates of that Job.

Depending on the type of information you are looking for, you may want to see the entries grouped differently (an extra line then separates the groups). To set your preference, select any entry, right-click and choose:

- **Grouped by Press Plate Set.** This groups all entries that were submitted together by the same Submit to Plate Merger task. Because these entries are likely coming from the same graphics file, the focus of this view is more on the delivery of these press plates (to ship or to move to press).

A similar view is offered in the Press Plate Sets view, but there you see a different kind of information in the right pane.

- **Grouped by Merged Plate.** This groups all entries with the other press plates that are or were part of the same merged plate. This focus of this view is more on the CDI.
Columns

**Note:** As in many Views in the Pilot, you can

- re-arrange columns by dragging their title to a new position,
- sort them by clicking on a column title,
- right-click a column title and choose to **Hide** this one or any other. In the list that appears, select **Select Columns**... if you want to change or re-arrange multiple items.
- use filters and optionally save them as a **Smart View**.

Several of these columns only get their value as the press plate progresses through its workflow.

- **File Name**: Name of the LEN file.
- **Folder**: Full path where the LEN file resides.
- **Order ID**: The order ID of the Job that the LEN files of the press plates reside in.
- **Resolution**: Resolution of the LEN file.
- **Size**: V-H size of the LEN file. (This is the size the plate merger uses when calculating layouts).

**Note:** The unit (in this and other columns) is the one chosen in the **Edit > Preferences > Units**

- **Device**: Name of CDI that the layout containing this press plate was made for. This field is empty when the state is still "In Plate Merger".
- **Ink name**: As read from the LEN file's XMP metadata.
- **Rotation**: Rotation as requested in the **Submit to Plate Merger** task: 0, 90 or **mq** (= "Set by Merge Queue").
- **Statuses** of press plates:

  **Tip:** Hover your mouse over a status icon to read its meaning.

  **Tip:** When using the filter, click CTRL to filter on multiple statuses.

- **In Plate Merger**: Still an entry in a merge queue of the plate merger.
- **In Output Workflow**: Part of a merged plate that is currently in its **merge queue's output workflow**.
- **Queued on CDI**: Part of a merged plate that is in a CDI expose queue.
- **Exposing on CDI**: Part of a merged plate that is being exposed on the CDI.
- **Exposed**: Part of a merged plate that was successfully exposed on the CDI.
- **Exposed (Warning)**: Part of a merged plate that was exposed on the CDI with a warning.
- **Error**: Part of a merged plate that was exposed on the CDI with an error.
• **Cancelled**: Part of a merged plate that was cancelled (removed) from the CDI "Exposer" queue.
• **Unknown**: Status unknown.

• **Imaging Technology**: The one requested for this LEN file when it was *submitted to the plate merger*.

• **Manufacturer, Thickness** and **Type**: Plate specifications, as retrieved from DFS or Grapholas during the workflow.

• **Timing**
  • **Due date**: Time specified in the *Submit to Plate Merger task*. When none was specified, a due date is set at 3 days after the submitting to the merger.
  • **Finished**: Time when this press plate was finished exposing on the CDI.
  • **Launched**: Time when this press plate was submitted to the plate merger.

• **Plate usage**, retrieved from the layout XML created by the plate merger:
  • **Used Area**: Area that this press plate uses on the merged plate.
  • **Waste**: Area of this press plate that is not used area. (press plate margins, cut marks area)
  • **% Used Area**: % of used area of the merged plate that this press plate is part of.
  • **% Waste**: % of non-used area of the merged plate that this press plate is part of.

**Note:** In previews of the merged plate, the waste area is shown in pink.

• When this press plate also requested a cutting workflow, these fields will get their values when that workflow is executed on the Kongsberg:
  • **Cutting Flow**: Name of cutting workflow chosen in the *Submit to Plate Merger task*.
  • **Cut State**: (Not) Ready for Cutting, Done, Error or Cancelled.

• **Custom fields** (names defined in the *Plate Merger item in the Configure tool*).

• **Internal ID numbers**
  • **Merged Plate ID**: A unique identifier for the merged plate that this press plate was placed on. In the reporting XMLs, it is mentioned as an attribute for Plate id. For example: `<Plate id="56c3-2ef4-0001">`.
  • **Press Plate ID**: A unique identifier for that press plate. In the reporting XMLs, it is mentioned as the element `<IdOnPlate>`. For example: `<IdOnPlate>000070518_20151210152733_process_Yellow</IdOnPlate>`. This ID was first created by the RIP when it created the LEN file and then added it to it's XMP metadata as `<egPlate:plateid>`.

Learn more in *Interpreting reporting XMLs* on page 66.

**Functionality**

Right-click an entry to choose any of these actions (some are only available in specific statuses):

• **Resubmit Press Plates**: This resubmits all selected entries back to the plate merger (same LEN files with same submit options). You will be asked to confirm.
This is useful when a part of a CDI plate was damaged or when your press operator requests a new plate of only that specific separation.

**Restriction:** The LEN file of the selected press plate still needs to exist (on the same folder).

**Tip:** The **Merged Plates view** also offers to resubmit (parts) of a merged plate.

- **Go to Job:** When the Pilot is in Container mode, use this to have the Press Plates view go to the Job mode of the Job that this press plate belongs to.
- **Go to File:** Opens the Files view and selects the LEN file of this press plate. This can be useful to check its XMP metadata (X).
- **Show in Plate Merger:** Shows this item in the Plate Merger Queue (when present there).
- **Go to Merged Plate:** Opens the **Merged Plates** view, zooms in on the merged plate that this press plate belongs to and selects that press plate in the preview (blue line).
- **Show Related Tasks:** This open the Tasks view and shows the workflow that was used to create the merged plate and submit it to the CDI.
- **View:** Opens the press plate's LEN file in the Automation Engine Viewer. This will require the LEN file to have prepared view data (learn more in *Working with RIP data in the AE Viewer*).

**Note:** If you wish to open LEN files in the DFS “View” application (aka "Esko Bitmap Viewer", Windows only), then choose 'Go to File' and double-click the file there. This will open the file in the application that you first instructed your local computer to 'open with'.

- **Group by Press Plate Set:** Use this to see the rows grouped by entries that were submitted together.
- **Group by Merged Plate:** Use this to see the rows grouped by the merged plate they ended up on.

**Note:** You cannot select and delete entries in this view. They will be removed based on the automatic clean up option in the **Plate Merger item in the Configure tool**.

### 2.3. Press Plate Sets

**Concept**

This views is intended for CSRs (Custom Service Representatives). It adds an overview of Job orders and the status of their required press plates in their workflow onto the CDI. This can also include the workflow of cutting the CDI plate on a Kongsberg table.

In Container mode, this view shows all press plate sets, created in a Job context or not. In Selected Job mode, it only shows those created in that selected Job.

**Tip:** Especially in Container mode, it can be useful to work with **Smart Views**: one could focus on plate status, another could focus on plate waste, etc.

**The Right Pane: Pie Chart and Details**

Select an entry to see a graphical overview and some key information in the right pane.

- The pie chart shows in color how many press plates of the selected set are in which **status**:
  - **In Plate Merger:** How many are still in the Plate merger, waiting to be put on a merged plate.
• **In Output Workflow:** How many were recently merged on a plate and are still in the merge queue's output workflow.

• **Queued On CDI:** How many are part of a merged plate that is in a CDI "Exposer" queue.

• **Exposing:** How many that are part of a merged plate that is current being exposed on the CDI.

• **Exposed:** How many that were exposed on the CDI but are still to be cut on the Kongsberg table (also see column "Cut State").

• **Error:** How many that experienced an error during exposing on the CDI.

• **Cancelled:** How many are part of a merged plate that was cancelled when being exposed on the CDI.

• **Cut Error:** How many where an error appeared during cutting on the Kongsberg table.

• **Done:** How many where the whole workflow is done successfully. These were exposed on the CDI and, if requested, also cut on the Kongsberg table.

• At the bottom of the right pane, click to see the amount and the names of all the Press Plates and (if available) Merged Plates for this set.

• "**In Plate Merger**" shows the amount and the names of the press plates that are still in that state.

In case you wonder why they are still in the plate merger, click or click on a specific press plate name to open the plate merger view and select them in their merge queue, where you can read details about their state.

**Tip:** Use the arrow buttons \[ \leftarrow \rightarrow \Rightarrow \Rightarrow \] in the Pilot tool bar to come back to this previous view.

• **In Error** lists the press plates of which a task in the workflow failed.

**Columns**

**Note:** As in many Views in the Pilot, you can

- re-arrange columns by dragging their title to a new position,
- sort them by clicking on a column title,
- right-click a column title and choose to Hide this one or any other. In the list that appears, select Select Columns... if you want to change or re-arrange multiple items.
- use filters and optionally save them as a Smart View.
Columns describing a status (see above list) show the amount of press plates of this set are in that status. The possible statuses are very similar to those described in the Press Plates view.

**Functionality**

- **Go to Job**: The view filters itself to the Last Used Job mode of the job that these press plates belong to.
- **Go to Folder**: The view switches to the Files view and selects the folder where the press plates' LEN files are. This is for example useful to check their XMP metadata (旮) or to manage their prepared view files.
- **Show in Press Plates**: Opens the Press Plates view and selects all press plates of this set. This is useful to check more detail about the different press plates or to see the ID of the merged plate(s) they ended up on.
- **View**: Opens all press plate's LEN files together in the Automation Engine Viewer. This will require all LEN files to have prepared view data (learn more in Working with RIP data in the AE Viewer).

### 2.4. Plate Merger

**Concept**

LEN files are sent to the plate merger by submitting them to a specific Merge Queue. Each merge queue has its own settings regarding plate type, size and merge parameters. For each merge queue, the plate merger calculates if it can merge the press plates (LEN files) in that queue onto a layout.

A plate merge queue starts to calculate possible layouts

- every time a new press plate enters the merge queue,
- every time a layout was decided, it then tries a next one,
- every time a press plate's due date is reached (or a time based on that due date),
- every time someone decides to Force Out one or more press plates.
- every time a merge queue setting was changed (one that is relevant for calculating layouts).

Press plates that you submit to a merge queue can be merged together on a same merged plate,

- when they have the same value for plate type, resolution, imaging technology and cutting workflow,
- and when they have the same value for custom Grouping Keys (that you can set up in the Configure tool).

**Attention**: The plate merger requires that the XMP metadata of the input LEN files contain information on hsize, vsize and resolution. This is the case for LEN files created by Imaging Engine or FlexRip version 14 or higher.

When a merge queue decides on a layout, the assigned output workflow is started. The first task in that workflow creates a LEN file of that new merged plate, the last one submits that merged plate to the CDI expose queue.
A Merge Queue Per plate Type

The best reason to have several merge queues is to have **a merge queue for each plate type**. Also when you have more than one CDI, we advise to let a merge queue pick a CDI automatically. This allows it to calculate more possible layouts, which improves the fill percentage in the decided layout. Later in the workflow, the **Submit to CDI task** sends the merged plate LEN file to the CDI that the merger created the layout for. Learn more below about **load balancing**.

Some remarks and advice when you consider **other reasons to create different merge queues**:

- Queues that start different workflows: For example, one queue could have an output workflow including extra steps for quality control.
  - However, a workflow itself can contain tools that decide conditional behavior (routers, SmartNames, etc.), so we advise to first check if it is possible to have one merge queue launching a workflow that includes different steps depending on the file's or Job's parameters.

- Queues that are not different in their queue settings but have differences in the way their output will be imaged (CDI parameters): For example, a merge queue that only handles exposure of 2540 ppi or Pixel+ press plates.
  - However, it is better to submit all these files to one same merge queue and use grouping keys to control the files they are merged with.
    - Important parameters like resolution and imaging technology are grouping keys that the system itself already uses automatically.
    - Learn about adding custom grouping keys in the page about the **Submit to Plate Merger task** on page 54.

Working with Partial Plates

When you want to use partial plates with fixed sizes, you can use the automatic workflow. Those sizes are then predefined in a merge queue. Mind that Automation engine is not keeping track of the offcuts.

When you want to use partial plates with variable sizes, we advise to use the DFS Merger in Automation Engine mode and create a layout for that unique size. Learn more about this workflow in **Using the DFS Merger in AE mode**.

Adding Test Strips or Margins to the Merged Plate

The Plate Merger can also add **test strips** or **margins** (frames) to the merged plates. This is done via a set of rules that you can set up in the **Plate Merger Configuration**. These rules are valid for all merge queues.

2.4.1. Adding a Merge Queue

Follow these steps to add a new merge queue:

1. In the Plate Merger view, click **+** and choose **New Merge Queue** (or use the **File** menu).
Attention: When choosing to Duplicate a merge queue, make sure that you do not change the name of the Plate Type to a non existing type, but do change the Name of the new merge queue itself.

2. Add a Name (or use the one that appears in the next step).
3. In Plate Type, click on \( \equiv \) to see a list of all available types (on the configured CDI devices). Select a plate type.
4. In Merge for, define for which sizes this queue needs to calculate layouts. This is decided by the Device, Drum and Size fields.

- **Active**: In this column, select or deselect the device that the merger can make layouts for. Learn more below about adding extra devices to merge for.

- **Automatic**: This is the default setting. The merger then checks all available CDIs and drum sizes to calculate which one offers the best fill percentage. In case the fill percentage is very similar for multiple CDIs, the merger chooses the CDI with the lowest queue load (see that estimated time in its device status box).

- **Add** or **Remove** extra devices. Some example cases to add specific devices:
  - You have two or more CDIs of a different size and you use a plate type that is not available for all of those. Then you could make a merge queue for that plate type that only merges for the CDIs where it can be used on.
  - You can add all your devices and de-activate the one that you know will become (temporarily) unavailable. Mind that the merger automatically detects when a CDI is not online. However deactivating a device it here may be useful to prevent that more jobs go to its expose queue. For example when you know that, in a few hours, that CDI will be offline for an intervention or maintenance.

- **Drum**: When you added a specific CDI in this list, the merger is automatically aware of what drum is present when calculating a layout. A example situation to still add a specific drum in this list, would be when you plan on changing the drum in the near future. That way, you can have a merge queue that already makes layouts for the new drum size.

To specify a drum, double click a device line, and in **Edit Size Options**, click on \( \equiv \) in **Drum Name** and select it from the list.
• **Size.** By default, the **Drum Length and Drum Height** will be used (as configured on the CDI). If you want a smaller size, type it in (for example for partial plates with a recurring size).

When a ⚠ warning sign appears next to the name of the device, hover your cursor over the icon to read its meaning. It may be that the plate type for that queue is not recognized.

5. **Merge Settings...**

• **Rotation:** Define if you allow the merger to rotate the press plate 90 degrees on the layout.

• **Auto-place Mode:** Choose the main mode this merge queue should base its calculation on:
  - **Area Optimized:** Layouts with the largest plate fill percentage.
  - **Cut Optimized:** Layouts that are optimized for manual cutting. Press plates will be placed in 'lanes' as much as possible, so enabling longer straight lines that are easy to cut manually.

• **Maximum Calculation Time.** *Each time a calculation is triggered*, this is the maximum time that the merge queue is allowed to spend on calculating a layout. When that calculation results in a layout, the merge queue then continues and tries again for that same period, now to make another layout with the remaining press plates. This continues until the merge queue can create no more layouts (with its current settings).

This time is spent on each calculation for each device this merge queue is asked to calculate for (30 seconds then means 30 seconds for each device).

When you have many press plates, increasing this time can help to create layouts with a higher fill percentage.

| Tip: The default time is visible when you create a new merge queue. |

• **Cut Marks.** Choose whether you want to add cut marks around each press plate. These marks are identical to those offered in the DFS Merger.

| Note: In the DFS-style preview or a merged plate, these marks and lines are visible as (small) green objects. |

  • **None.**

  • **Cutting Marks.** Small marks indicating the corners. The marks will be as long as the width of the **Press Plate Margins** (with a maximum length of 5 mm). An example:

  ![Press Plate](image)

  • **Solid Cutting Lines.** Cutting lines around the press plates.
- **Dotted Cutting Lines.** Dotted cutting lines around the press plates.

- **Press Plate Margins.** You can add an extra empty area around each merged plate. This is also where the cut marks are placed.

  **Note:** When you here add 10 mm, the space between 2 press plates will be 20 mm.

  **Note:** When you add **Cut Marks**, 1 mm of press plate margins will be added automatically. When you requested to add a text label to the press plate, a 4 mm margin will be added to the side where the label needs to appear (unless there was already such a margin).

- **Minimum Fill.** Define the minimum fill for a merged plate.

  **Tip:** Based on your workflow and production needs, you will need to find a balance between optimal plate usage and urgency of exposing the plates. Especially when your merge queues often contain press plates of variable sizes, it may be beneficial to wait until some (more) small ones are submitted to help fill the CDI plate (and so reduce plate waste).

- **Merge Automatically** before the due date. Use this option to ensure that you make the CDI plates by their due date (the time specified in the Submit to Plate Merger task). When you need to ship the press plates by 5 PM, you could for example make sure that they are merged by 3 PM, so leaving enough time for exposing, post-processing, cutting and packing.

6. **Workflow.** Select the output workflow for this merge queue. As mentioned in the introduction, this workflow needs to start with the Create Merged Plate task and end with the Submit to CDI task. Only global workflow tickets are possible.

  **Caution:** In theory you can extend this workflow with other task steps but then make sure you still respect the required task input files in this workflow:

  - The layout that the merger calculates is an XML file. This first step of this workflow, the Create Merged Plate task, needs that file as its input file.
  - The output file of the Create Merged Plate task (also an XML file) needs to be the input file for the Submit to CDI task.
Note: When the selected workflow is launched for the first time, a predefined set of workflow parameters will be injected in this workflow and can so be used by the steps in this workflow. The values of these workflow parameters will set every time the workflow runs,

- cdi.drum: Name of the drum of the CDI as defined in the Expose application on the Grapholas PC
- cdi.id: internal id how the CDI is configure within the Automation Engine server
- cdi.name: Name of the CDI Device as configured in the Devices View
- CutWF: Name of the cutting workflow used in the Submit to Plate Merger task.
- ImgTechn: Imaging technology set in the Submit to Plate Merger task.
- mq.mergerxml: URL of the input file of the workflow
- mp.type: Plate Type as configured in the Merge queue
- mq.name: Name of the Merge Queue.
- PlateType: Plate Type as configured in the Merge queue
- Resolution: Resolution of the Merged Plate
- User defined name of the grouping keys as defined in Configure > Plate Merger > Name Custom Field.

7. Click OK to confirm and create the merge queue.

Note: You can also select an existing merge queue, right-click or click ☁ and choose Duplicate to create a similar queue.

2.4.2. Managing Merge Queues

Pausing a Merge Queue

Attention: When your setup is a standalone Device Manager, the merge queues will always be paused. You will also not be able to Hold or Release items in these queues. Contact Esko to learn how to extend this functionality.

Select a merge queue, right-click or click ☁ and choose Pause Merge Queue to stop a merge queue from trying to create layouts. The icon of the queue then changes to 🔄. Press plates can still be added or removed, but no automatic merging will take place.

Choose Resume Merge Queue to activate the queue again (_redirected).

Pausing a merge queue is interesting in these cases:

- When, during busy production, you want to change some settings to the merge queue.
• When you are used to work with *layout proposals*, you sometimes want to pause the queue while investigating the proposals.

• When you use the *DFS Merger in Automation Engine mode*, the DFS will automatically pause the merge queue that you selected there.

**Tip:** There is no need to pause a merge queue because a CDI is down or offline. The merger automatically detects this device status and will resume merging for that device as soon as the CDI is available again.

---

**Viewing and Managing Queue Entries (Press Plates)**

To define which columns you wish to see, go to *View > Select Columns in ...* or right-click on a column header and (de)select the type. You can also drag columns to a different position.

Select an entry to see a panel with information on the press plate (LEN file), including its submit date and due date.

The plate merger works fully automatic but there are some manual interventions you can still do on selected press plates:

• Click 🚫 or right-click and choose **Hold** to prevent the merger from considering these entries.

• Click 🚫 or right-click and choose **Release** to release these entries that were put on hold.

• Click 🚫 or right-click and choose **Force Out** to force the merger to create a layout instantly including the press plate(s) you forced out. In this case, the queue's setting *Minimum Fill* is ignored. The merger also tries to add other press plates to that layout (that were not forced out but were in 'waiting' status).

The merger creates as many layouts as needed for all the forced out entries and then falls back on its usual calculation schedule.

• Click 🚫 or right-click and choose **Delete** to remove the press plate from this merge queue.

• Click 🚫 or right-click and choose **Info** to see the XMP metadata of the press plate's LEN file.

**Tip:** The dedicated view *Press Plates* offers more information and functionality on press plates.

• Right-click an entry and choose **Go to File** to open the Files view and see the related LEN file selected in its (Job) folder.

An entry in a merge queue can have these statuses:

• **Waiting** for the merger to be placed on a layout.

• **On Hold**, not available for the merger until released again.

• ** Forced Out.** The queue entries that you forced out are still available in the queue with this status until they disappear a few moments later (once the merger finished calculating which other 'waiting' entries could also be put on the layout).

• **Rejected.** Hover your mouse over the icon to read details. When a press plate remains stuck in a merge queue, it most probably rejected by all targeted devices because of one or several of these reasons:

  • The press plate is too big for the device.

  • The press plate's resolution is not available on the device.

  • The press plate's imaging technology is not available on the device.

  • The press plate's imaging technology is not available for the plate type on the device.

  • The press plate contains HD screens and the device does not have an HD Flexo license.
• There are no devices available to merge for.
• The plate merger’s output folder is low on disk space.
• The selected cutting flow file does not exist anymore.
• There is an unsupported drum installed. Sleeve and pre-mount drums are not supported.
• The reason is unknown.

About Load Balancing

As mentioned above, when you allow a merge queue to create a layout for more than one CDI (“Device: Automatic”), then, if the plate fill percentage is very similar, the merger will choose to create the layout for the device with the least work to do (based on the estimated time mentioned in the device’s status box).

When due date is more important than waste reduction

The plate merger’s focus is on making layouts with the least waste. When submitting press plates, you can also define a due date. Follow these steps to make layout and output decisions (also) based on this due date:
1. In Plate Merger view, select a merge queue and select all entries in that queue.
2. Click to put them all on hold.
3. Sort the list on due date by clicking on the header of the column “Due Date”.
4. Select those that, for example, must be delivered within the next 3 hours.
5. Click to release these entries.
6. Optionally, go see the layout proposals of this queue (unless the queue’s already decided on a layout and created merged plates).

Managing the Merger’s Output Files

The plate merger creates many files in the folder that was defined in the Plate Merger item in the Configure tool. You can there also define when these data should be cleaned up.

2.4.3. Plate Merger Configuration

Note: Learn about the Plate Merger concept and View in the chapter CDI Platemaking Workflow.

To configure your plate merger, go to Pilot > Tools > Configure > Plate Merger.
• Tab ‘Setup’ on page 26
• Tab ‘Reporting’ on page 28
• Tab ‘Test Strips’ on page 31
• Tab ‘Margins’ on page 34.

Tab ‘Setup’
• **Output Folder:** This folder stores files created by the plate merger, in many subfolders. These are the files you see when you use the feature **Open in Browser** on entries in the **Merged Plates view**.

The (large) LEN files that were created by the **Create Merged Plate task** also reside here. The DFS Exposer application downloads them from this folder when he starts exposing.

**Caution:** Do not manually manage any of the files in this folder or its subfolders.

Click ▶ to change the default path to a custom one.

**Caution:** When changing this folder, make sure there are no more files in there that are used by the merger.

• When you select **Automatically delete files in subfolders (except reports)**, define in **Clean up after** after which time you want all these temporary files to be deleted (merged plate LEN files, GIFs, XMLs, etc.).

**Attention:** A merged plate cannot be **resubmitted** to be exposed again when its related files in these folders have already been deleted.

• **Name Custom Field 1 - 5.** Many of the CDI related Views show columns. If you want to use any of these 5 custom columns, enter their name here. The value of custom fields can be set in the **Submit to Plate Merger task**.

• Select **Use as grouping key** if you also want to use that custom field as a grouping key in the plate merger's merge queue. Grouping keys limit the plate merger's freedom to decide which press plates can be considered to be placed on a same merged plate.

• Select **Use the Customer field as grouping key** if you want to avoid that press plates from different customers (when specified) are placed on a same merged plate.
• **Cutting Workflow.**

When a merged plate was exposed on a CDI that will be cut on a cutting table, this workflow will automatically be started.

This workflow is launched on the XML that contains the cutting information that was originally defined in the *Submit to Plate Merger task*.

• When you use a Kongsberg table, the workflow needs to submit that XML file using the *Submit to Kongsberg Table task*.

• When your cutting table is not a Kongsberg, you need to create a workflow that selects the cutting instruction file itself and then forwards that file to the cutting table. This can be done by using the *Select Referenced file task*. An example:

Learn more about cutting CDI plates on a Kongsberg table in the chapter *Kongsberg Production Workflow*.

**Tab 'Reporting'**

These fields allow to automatically launch a workflow at any of the specified moments. These workflows serve to send feedback to external systems, to inform them on status or deliver information that helps cost calculation.

**Note:** In stead of waiting for workflows to send this information, an external system can also get such information on demand. Lean more in *External Systems Requesting Information* on page 29.

The input file for these workflows is decided automatically. These input files are XML report files containing specific information that is valid at that time.
**Note:** These XML report files are picked up from a subfolder 'Reports' of the Output Folder defined in this panel. These files are not deleted by the clean up tool in that panel. You could choose to have the workflow that you launch on them also delete them at the end (or after a few months for example).

- **When a merged plate is submitted on a CDI:** This is each time a Submit to CDI task sends a merged plate to a CDI "Exposer" queue. This report is also available as a link in the task details of a finished Submit to CDI task.

- **When a merged plate is exposed:** Each time a merged plate is exposed, this XML can deliver information about the device, plate usage, waste, etc. This workflow is also launched when the merged plate was cancelled (removed from the CDI expose queue).

- **When all press plates for a job are exposed:** When all plates of a press plate set are exposed (or cancelled), this XML can inform on which job, which plates, when, plate usage, etc. This XML can for example describe the plate usage by the job's 5 press plates that ended up on 3 different merged plates.

- **When a merged plate is cut:** Learn here how and when the CDI workflow communicates plate cutting instructions to a Kongsberg cutting table (IPC). The workflow that you define here will be launched each time such a flexo plate was cut.

Learn more about these XMLs in Interpreting reporting XMLs on page 66.

The most simple workflow to launch on those XML files could be a "Copy or Move File" task to make that XML file available to another system. Here is an example of a more advanced workflow to feedback such events to a business system:

Learn more about delivering information to external systems in this dedicated chapter.

**External Systems Requesting Information**

**Concept**

External systems (MIS, ERP, ...) are especially interested in how much flexo plate was used for a job. They use this information to help decide the cost for that job. In stead of waiting for workflows to send them this information, external systems can also get this and other information on demand. Some want to see what is still waiting in the merge queues. Some want to see the overall status of the CDI device(s).

1. **Requesting info on how much plate was used for a job (cost, statistics)**

   An external system can do HTTP calls to request status information of all Press Plates of a specific Job. To do this, the external system needs to execute an HTTP 'GET' request. It will get an XML file as a result.

   **Syntax:**

   **Tip:** As a test, you can also execute HTTP requests via a browser.
• **Input:**

Syntax of the URL to HTTP-GET the XML report:

http://<name-of-AE-server>:4412/FPL/job/<jobname>

• `<name-of-AE-server>` = the name of the Automation Engine server (the master server).

• `<jobname>` = the **Job Name** of the job of which you want the XML report.

Example: http://<name-of-AE-server>:4412/FPL/job/1234banana

**Note:** To get an XML where the list of Press Plates are listed per **Press Plate Set**, add the parameter 'groupperset=1'. The "Images" (Press Plates) within the XML element 'Images' will then be grouped per 'ImageSet'.

Example: http://<name-of-AE-server>:4412/FPL/job/1234banana?groupperset=1

• **Output:**

An XML report describing all Press Plates related to that Job, including their current status.

2. **Requesting info on what is still waiting in the merge queues (job load)**

The amount of press plates that are still in merge queues also predict the work load for the next hours.

**Syntax:**

• Go to http://<name-of-AE-server>:4412/FPL to see an information page.

• There, in the topic **Live PlateMerger queue Updates(/MQ)**, click the link to see the 'Server Sent Events'. The 'Server Sent Event' source can be reached at http://<name-of-AE-server>:4412/MQ/SSE. An example:
Per Merge Queue, the following information is returned:

- NAME: Name of the merge queue
- IDLE: "TRUE" when the merge queue is not merging/calculating proposals
- IDLE: "FALSE" when the merge queue is merging/calculating
- PAUSED: "TRUE" when the merge queue is put on hold
- PAUSED: "FALSE" when the merge queue is active
- QUEUELENGTH: Number of entries currently in that merge queue.

### 3. Requesting info on the CDI device

HTTP calls can also be used to retrieve information about the CDI Device status. This enables you to show what you see in the CDI Device view in your own custom dashboard.

Learn more in *CDI Device Status in an External Dashboard* on page 11.

### Tab 'Test Strips'

#### Concept
You can here define which test strips that the plate merger needs to add to the layouts it makes. These test strips are LEN files that you created earlier.

You here define one or multiple rules that define when which test strip needs to be added. These rules are valid for all merge queues.
A test strip's position and orientation on the layout is fixed. Following the orientation as used in the previews in the Pilot, the position of the test strip is always bottom left and vertical (rotate -90). An example:

![Test strip example](image)

**Note:** When calculating layouts, the plate merger first puts the test strip on the trial layout and then checks how to fill the remaining area. The surface of a test strip is also calculated when calculated a required fill percentage.

**Attention:** On a merged plate, test strips are not counted as press plates (which together represent the used plate area). This means that adding test strips increases the waste area of a merged plate.

### How to Add a Test Strip Rule

1. First register the test strip file. In **Registered Test Strips**, click **Add**, browse and select the file. The system will create a thumbnail and show you its **Details**.
2. Then define a rule when this test strip should be used. In 'Define rules ...', click **Add** and **Name** this rule.
3. Set the **Conditions** that need to apply for this test strip to be placed on the layout.
The most typical condition for such a rule is to add a test strip with the same resolution as the other press plates on the layout. Other conditions usually are imaging technology, plate type or adding them customer specific.

**Note:** Creating these rules is very similar to creating filters in the Pilot. Learn more [here](#).

See this example where one of the *custom fields* (that is also used as grouping key) helps to decide if this merged plate needs a test strip or not:

4. Select the LEN file for this rule (from the list of the ones you registered earlier).
5. Optionally, add a *Label* to this test strip. This text will appear along its long side. A margin is created automatically (on all four sides of the test strip).

**Tip:** It may be useful to add the plate name as a label above the test strip. This way, after cutting, you can still find back which strip was used for which press plates. For example, when you want to check a complaint on a certain press plate, then follow these steps to find the test strip that was also on that same CDI plate:

1. In the Press Plates view, look up the press plate entry (filter via via job, orderid, id on Plate, file name, etc.)
2. Right-click this entry and choose **Go to Merged Plate**.
3. Write down the *Name* of this merged plate. It is mentioned top right and has an extension `.par`.
4. Use this name to find the test strip in the (physical) archive of your used test strips.

6. Click **OK**.
7. Click **Move Up / Down** to define the order in which multiple rules need to be executed. Put specific ones at the top and general ones at the bottom.
8. (De-)select the toggle next to a rule to (temporarily) de-**Activate** that rule.
9. Use **File > Save** to save your settings. These rules are then instantly picked up by all plate merger queues.
Tab 'Margins'

This tab allows to add extra margins around merged plates created by the Plate Merger. You can add different margins per top, bottom, left and right side.

**Note:** DFS applications refer to these margins as 'Frames'.

You can define these margins through a list of rules. Each rule can add margins for a specific combination of a device and a drum size. Use the Add Up / Down buttons to define the order in which the rules should be executed.

**Tip:** A last rule could be one for Any Device and Any Drum. The plate merger will use this one for all situations that were not specified in any rule set above.

The top, bottom, left and right sides match to the orientation that is shown when viewing the merged plate as shown in these places:

- in the DFS "Exposer", in the Info dialog of that queue,
- in the Merged Plates view,
  - in the preview dialog that opens when you select an entry, right-click and choose Open Preview.
  - in the previews that, when you select an entry, are shown in the right side panes.

### 2.4.4. Working with Layout Proposals

**Concept**

When a merge queue has decided on a layout, the output workflow creates a merged plate. However, there are several cases when you might want to see which Layout Proposals this merge queue has calculated but rejects as a final merged plate because they are not fully conform to the queue's Merge Settings (the required minimum fill %).
In the view **Plate Merger**, right-click any merge queue and choose **Show Layout Proposals** (or use Alt/CMD-Down) to open a **view that shows the layout proposals**. You can then choose which one you want to 'force' **Expose**. You can even **edit a layout proposal** before exposing it.

These are typical cases where you may want to see and or change these layout proposals:

- **Why is this press plate still waiting in the merge queue?**
  You typically have double-checked the settings of the merge queue, but you still wonder why the workflow does not continue.

- **I want to understand in detail how this merge queue decides a merged plate.**
  Looking at the (rejected) layout proposals helps to understand how the settings of this merge queue affect the layout calculations it makes.

- **As a CDI operator, I want to see all layout proposals for a specific CDI, so I can choose which merged plate to expose next on this CDI before its queue runs empty.**
  Even in a workflow where you expect the best layout proposal to be chosen automatically, a CDI operator might still want a moment of visual control over which proposal should become the merged plate.

- **I want a visual overview of layout proposals based on their urgency.**
  Sometimes, the urgency of a plate is more important than its waste percentage and you manually want to decide this priority.

- **I want to manually inspect or optimize the laser beam count of a layout.**
  Sometimes you can manually optimize the speed in which a plate will be exposed by re-arranging press plates on the layout.

### Inspecting and Exposing Layout Proposals

This view shows the layout proposals of one or all merge queues. You can inspect them. You can choose to expose a selected one. You can not delete a layout proposal. The next page explains how you can **view a layout in detail and possibly make changes** before exposing it.

**Attention:** This view does not show **all** possible layouts; there could easily be millions of combinations. It only shows the **best** proposals, the ones with the least waste.

The top bar in this view is in a light yellow color. This can help remind you that you are looking at proposals, not at Merged Plates.
1. Click **< Merge Queues** (or use ALT/CMD-Up) to leave this view and go back to the list of press plates of this merge queue.

**Note:** To avoid navigating back and forth, create an extra Tab to view both modes (File > New Tab).

2. Name of the selected merge queue. The icon indicates if the queue is active or paused.
   - Double-click it to open the queue's settings.
   - Right-click it to select a different merge queue. This avoids having to navigate away from this view. You can also select this view for **All Merge Queues**.

3. This number shows the amount of press plates in this merge queue (no matter what state they are in).

4. Click '**Request Auto Merge**' to manually trigger the merger to (re-)calculate layout proposals.

**Tip:** When new press plates are submitted when the merge queue is paused, this view will not change. You can then click this button to trigger a new calculation of proposals.

**Note:** While the merger calculates, this button changes to '**Cancel Auto Merge**'.
**Tip:** When, after a short while, you still do not see any change in the proposals, go see the list of entries for this merge queue and check any error message(s) in their details pane. They could show that entries are "too big" or request "unsupported imaging technology".

5. **Resume Merge Queue** or **Pause Merge Queue**: A shortcut to pause or resume this merge queue (without leaving this view).

6. Layout proposals can be shown in several ways.

**Tip:** Use the slider in the Pilot’s top bar to change their display size.

**Tip:** Use the arrow buttons to navigate through the proposals.

Right-click anywhere in the overview area and choose from:

- **"Arrange by"**
  - by **Device** (as in above screenshot): Grouped per device. These are the devices that are listed in the settings of the Merge Queue, in "Merge For".
  - by **Size**: Grouped by size of the layout.
  - by **None**: This shows all of them, now no longer in one horizontal list but in a continuous display using any rows below.

- **"Sort by"**: Choose which layout is shown first:
  - **Waste**: The one with the smallest waste percentage.
  - **Due Date**: The most urgent one.

- **"Organize by Layout"**: Identical layouts are then shown in stacks that you can browse through. This is especially useful when you have multiple CDI devices that are using the same plate size. You then also typically arrange the view by plate **Size**.
Note: An example: You have two Spark 5080 devices using a same size plate. You asked to calculate layouts for both devices. You switched on 'Organize by Layout' and 'Arrange by None'.

When you click on the arrows beneath the stacked layout, a next layout in this stack is shown. This other layout however will typically look identical. This is because the layouts in a stack have the same layout of the same press plates.

What typically does change in a stack of layouts is the name of the device: these are identical layouts made for more than device.

7. The amount of layouts (or layout stacks) shown in this arrangement (device/size).
8. The total amount of layouts (or layout stacks) shown for this merge queue.
9. • Device name (when not viewing 'Arrange by Device')
   • Layout size (when not viewing 'Arrange by Size'). If this layout is chosen to be exposed, this is then the size of the merged plate.
   • Due dates, shown in red when it is overdue.
   • Waste percentage
10. Information about the selected layout proposal. Learn more in Merged Plates.
   • Beams: This shows the average beam count for the entire layout. This gives an indication how long it will take to expose this layout.
   • Grouping: These are the values of the parameters that were involved in grouping these press plates onto a same layout (both system level and custom grouping keys).
11. As mentioned above, not all layout proposals are shown, only the best ones.

The top screenshot on this page shows such an example:
   • The selected proposal (bottom left) for the Spark 5080 shows that here are 4 press plates for the 'Shrek' job: C, M, Y, K.
   • Above, on the smaller plate for the Spark 2530, only one proposal is shown, including only C, M, K. There are other layout proposals for this smaller plate, but showing those here brings no extra value: Or they contain a same amount of press plates from a same
Choosing to Expose a Layout Proposal

When you want to output a layout proposal, right-click it and choose **Expose**. This will remove it from this view and start the assigned output workflow for this merge queue (creating a merged plate and sending it to the CDI).

When you choose to expose a layout, the current list of proposals disappears. This is because the plate merger immediately recalculates new layout proposals, now using the left-over press plates.

**Note:** You can change a proposal before exposing it. Learn more below.

Inspecting and Changing a single Layout Proposal

Detailed View of a Layout Proposal

In the overview of layout proposals, double-click a proposal to open it in a different view where you can inspect and change it.
1. Press **Layouts** to go back to the overview of layout proposals.

**Attention:** When you leave this view, any possible changes to this layout proposal will be lost.

2. Click **Pause Merge Queue** or **Resume Merge Queue** to pause or resume this merge queue. Similar buttons are available when you are viewing **All Merge Queues**.

3. The **Info** button shows a right pane with details about the layout proposal (top) and about the selected press plate (bottom).

4. The **Press Plates** button shows a right pane that assists you when manually placing the press plates. Learn more in **Working with the List of Press Plates** on page 44.

5. This is the width and height of the layout proposal. Use the numeric fields (including calculator) or the **cropping icons**.

6. This is the X and Y position of the selected press plate. Use the numeric fields (including calculator) to re-position it or use the icons to center it on the layout. Learn more [here](#).

7. This is the beam count for this vertical lane of the layout. Learn more in **Information on Beams used per Lane of Press Plates** on page 41.

8. This indicates how many (selected) press plates there currently are on this layout.

Notice the different colors for sizes and margins:

1. Drum size (grey). This grey area is not visible when the layout is the size of the drum.
2. Layout size (when exposed, the size of the merged plate) (pink).
3. **Merged plate margin** (darker pink).

In this mode, you can measure details, inspect beam counts, change the layout and choose to expose it from this view.

**Note:** Editing features that are not available here might be part of the separate application "DFS Merger" (for example the tools for a PlatePatcher workflow).
Information on Beams used per Lane of Press Plates

Sometimes, the urgency of a plate is more important than its waste factor. To help judge the speed that the plate will exposed with, you also see the predicted amount of laser beams per 'lane' of press plates.

1. In the center of each press plate, the number in the black rectangle indicates the maximum amount of beams that this device can expose this press plate with. For example.

Note: This beam count is based on the angle, ruling and resolution of the LEN file.

Note: No number is shown when the press plate has no screened data or when its XMP metadata does not mention screening information.

Select a press plate to see more info in bottom part of the details pane on the right:

- **Beams**: This list all possible beam counts for the selected press plate.
- **Select Allow all beams** when you want the beam count only to be based on resolution.

Note: In the "DFS Merger", this option is called "Testform".

Caution: Enabling this option can cause moiré on the exposed plate.

Some examples cases where this can be useful:

- When there are only solids in the press plates (0 or 100 %).
- When you do not want the presence of a halftone object to slow down the exposing of the full plate. This could be an image in a test strip or for example a small image.
that was triggered by a SmartMark. The quality of such images may be less important, so you do not want them to slow down the exposing.

- When exposing a plate with only test charts where the halftone data is not important.

2. At the bottom of the layout proposal, a small number shows the highest possible common beam count for all press plates in that specific vertical lane (in DFS referred to as 'Stripe'). A random colored horizontal line above this number indicates the width of the lane. This number is re-calculated every time the layout changes.

**Note:** Sometimes, by *swapping* 2 press plates, you can increase the beam count for a lane, and so expose the plate faster.

When this view cannot detect or calculate a number, it will show the default minimum of '4'. An example: In above screenshot, the press plates of the 2 of the wine label repetitions (bottom left) have no screened data and so the beam count for their lanes is '4'. Solve this by selecting them (one by one) and selecting *Allow all beams*.

**Note:** The beam count shown here is only a calculated prediction. The real beam count used during the exposing is decided by the DFS when it reads the LEN file of the merged plate. This view could for example show '4' because of press plates without screening, while the CDI itself can decide it can and will be higher.

### Changing a Proposal before Choosing to Expose it

This view not only allows close inspection of a layout proposal but you can also make changes to its content or to its size. However, you can not save these changes. These changes only serve to make a more optimized layout right before you choose to *Expose* it.

**Tip:** All changes can be undone (use CTRL/CMD-Z).

**Note:** To select multiple press plates:

- Hold CTRL/CMD while selecting.
- Click and drag an area. All press plates touched by this area will be selected.
- Use CTRL/CMD-A to select all.

**Functionality:**

- **Moving** press plates:
  
  - By dragging: Select one or more press plates and drag them to another position. The snapping tool helps you to position them accurately (see the assisting blue lines). A dark red color indicates an overlap with other press plates or any position outside the layout area.

  **Note:** When multiple press plates are selected, the movement is done on the bounding box of the selection.

  - Numerically: Select one or more press plates, enter a new value for x or y in the details pane and confirm by pressing Enter or Tab.

When multiple press plates are selected, the position can be specified in an absolute or relative manner:
• When the entered value starts with + or –, the value is interpreted as a relative value. All press plates are moved, relative to their current position.

• When the entered value does not start with a sign, the value is interpreted as an absolute value. All press plates are then moved to the exact position that was entered (and are probably overlapping).

• Centering: Select one or more press plates and, in the X or Y fields, click on ![center symbol] (center horizontally) or ![center symbol] (center vertically).

**Note:** Press plates that overlap or are moved outside the layout area are highlighted in red. Warnings will appear when you then choose to **Expose**.

• **Rotating** press plates:

  Right-click your selection and choose **Rotate** to rotate them 90 degrees clockwise or, when they already were rotated in this view, counter clockwise.

  **Attention:** Before rotating, the system checks two options used when submitting these press plates to the plate merger:

  • When one or more press plates were submitted with a forced rotation (0 or 90), a warning appears. You can choose to **Rotate Anyway** or **Cancel** this request.

  • When you submitted these press plates without allowing different rotations, the plate merger might have decided to rotate them all, as a group. When such a group rotation is detected, you will be asked to choose between **Rotate Anyway** (only those you selected), **Group Rotate** (also those in the rotation group) or **Cancel**.

• **Swapping** press plates:

  Press CTRL/CMD and click to select 2 press plates. Then right-click this selection and choose **Swap** to make them swap position. Their rotation will not be changed.

• **Removing** press plates:

  Right-click your selection and choose **Remove** to remove these press plates from this layout proposal.

• **Changing the size of the layout area:**

  • Automatically: **Cropping** the merged plate. You can crop the (pink) layout area to fit to the area taken by the press plates. This allows you to create a partial merged plate (in case you choose to expose that layout). All required margins will remain.

    To do this, click the crop buttons in the W or H input fields:

    • Click ![crop symbol] to crop and fit the layout horizontally.

    • Click ![crop symbol] to crop and fit the layout vertically.

    • Numerically: Enter a new size in the W or H input fields. Remember you can use these fields as a calculator.

  • Right-click a press plate and choose **Go to File** to see the LEN file of press plates selected in the Pilot’s Files view.

  • Right-click a press plate and choose **Info** to open the dialog showing the XMP metadata of this LEN file.
• Right-click a press plate and choose View to open the related LEN file in the Viewer. This is only possible when prepared view data is available. Learn more in Viewing RIP data.

• Right-click anywhere in the layout and choose Expose to start the output workflow for this layout proposal.

Working with the List of Press Plates
In the right pane, the button Press Plates lists the press plates that were placed on this layout proposal.

In the list, the icon ![ ] below their thumbnail indicates that this press plate is still present on the layout proposal. Those without this icon were manually removed by someone in this view.

To place removed press plates back onto the layout, simply drag and drop their thumbnail onto the layout.

In the list:
• Double click a thumbnail to select that press plate on the layout.
• Use the search field to reduce the list or to find a specific press plate.

2.5. Merged Plates

Concept
This view gives an overview of all Merged Plates that the Plate Merger created.
When your Pilot is in 'Last Used Job' mode, you will only see the merged plates of that Job.
Merged Plates are kept in this database until they are removed by the cleanup settings that you define in the Plate Merger item in the Configure tool.

Note: This view does not show merged plates that someone created manually in the DFS merger using LEN files from a (local) “working folder”. It does show merged plates that the DFS merger made in "AE mode" (using press plates that were present in a Plate Merger queue).

Select a merged plate to see a preview and its key attributes in a right pane.

In the preview, the pink area represents the non-used area (waste).

Note: Test Strips are also shown in the preview and are also counted as waste:

Columns

Note: As in many Views in the Pilot, you can
- re-arrange columns by dragging their title to a new position,
- sort them by clicking on a column title,
- right-click a column title and choose to Hide this one or any other. In the list that appears, select Select Columns... if you want to change or re-arrange multiple items.
- use filters and optionally save them as a Smart View.
Most columns are identical to those already mentioned in the Press Plates View. We here only describe those specific for this view:

- **Height** and **Width** of the Drum.
- **Total Area**: Height x width, the maximum area that can be imaged (drum surface.)
- **Total Used Area**: Imaged area (the area occupied by press plates on the merged plate).
- **Waste**: Total non used area of the merged plate.
- **Name**: The grapholas parameter file (.par), containing detailed exposing parameters.
- **Estimated**: The estimated **Exposing Time**. For example 12:27 means 12 minutes 27 seconds.

**Attention**: CDI's with a Grapholas version 12 up to v14.0 offer a more limited interface with Automation Engine. The estimated expose time is then not accurate; it will often be too short.

- **Creator**: 'MQ' indicates this plate was created by a merge queue (Automation Engine). The name of that merge is mentioned in Merge Queue Name.
- **Merged By**: It describes which technology was used to merge this plate. It can also indicate who manually intervened.
  - "AutoMergerProposal" indicates it was done by the automatic algorithm of the Plate Merger.
  - "Manual" indicates that someone manually intervened in the layout. The network IP number indicates on which computer this was done. The user name is also mentioned.
    - "_DFSMerger" indicates that the layout was decided in the application "DFS Merger".
    - "_Pilot" indicates that the layout was manually changed in the Pilot before choosing 'Expose'.

**Functionality**

After selecting an entry, right-click or choose the icon in the tool bar to:

- **Reconsider**: This resubmits all the press plates of this entry back to the plate merger and it removes the entry from this CDI "Exposer" queue. It also removes the entry for that merged plate in the Merged Plates view.

  This feature is interesting when you think that you can get a better fill percentage on this merged plate when some of the new (smaller) press plates that recently arrived in the merge queue could also become part of the layout.

- **Resubmit Merged Plate**: This resubmits the merged plate back to the CDI's "Exposer" Queue. A dialog opens where you can choose the CDI. By default it proposes the one that was used before. When you confirm this choice, you will immediately see it appear as a new entry in the CTP Queues view, at the end of the queue of the chosen CDI. When the chosen CDI is incompatible for this job (due to different imaging technology for example), you will get a warning and will not be able to resubmit.

  Most typical use cases:
  - when a CDI plate was damaged and you need to remake the whole plate again, in exactly the same way.
  - when the CDI plate (that you do not need to cut) is used for a very long print run and a press operator asks you to create an extra exact copy of that CDI plate.
Attention: This does require that the LEN file of the merged plate has not been cleaned up yet (see setting in the Plate Merger Configuration).

Note: Resubmitting a merged plate also creates, for each press plate on that merged plate, a new entry in the Press Plates view. It also affects the numbers in the Press Plate Sets view, in its columns Merged Plates and Press Plates.

- **Resubmit Press Plates**: This resubmits all the press plates on this merged plate to the plate merger (those same LEN files with their same submit options).

  The difference with the above "Resubmit Merged Plate" is that the press plates may this time end up on a different kind of layout, on a merged plate that looks different.

  **Attention**: Note that, if the selected merged plate is still in the CDI "Exposer" queue, that this does not remove it from that queue. If you do wish to also remove the item in the CDI "Exposer" queue, then we advise to use the feature ‘Reconsider Merged Plates’ that is available on items in a CDI "Exposer" queue. Learn more [here](#).

- **Show in CTP Queues**: This opens the CTP Queues View with this merged plate selected.

  **Note**: When you delete the queue entry there, its merged plate will still be part of the Merged Plates view but its state will be on Done, with errors.

- **Open Preview**: This shows the merged plate as it would look in the DFS Merger.

  ![Preview Image]

  1. The red area indicates the merged plate margins, as set in the Plate Merger Configuration.
  2. The light grey indicates the press plate margins, as set in Merge Settings of the used Merge Queue.
  3. The green objects indicate cut marks or lines, as set in Merge Settings of the used Merge Queue.

  **Note**: This type of preview also shows a preview of any placed test strips.

- **Open in Browser**: This tool is not required in normal daily use, but can be helpful to easily access the files created in background (in the folder as defined in the Configure tool), for example to read the XML file.
Zooming in on a Merged Plate

Double click an entry to get a closer view of the content of that merged plate.

Click the < Merged Plates button to see this merged plate back in the main (list) view of the merged plates.

Note: You might have landed on this view directly from another view (for example by using the "Go to Merged Plate" option in the Press Plates view). If you then want to go back to that previous view, use the toolbar button instead: < > .

When you select a press plate, its key info is added to the right pane.

You can use CTRL-click to select multiple press plates and see their names highlighted in the panel.

Functionality:

After selecting one or multiple press plates, a right-click offers to:

- **Resubmit Press Plates**: Also here you can resubmit the selected press plates back to the plate merger, where they will start their workflow again from that point on. The way they are submitted is identical as when they were originally submitted to the plate merger (same plate type, imaging technology, grouping keys, etc.).

  **Attention**: This does not remove them from this merged plate and this does not remove the merged plate. This function is therefor useful when the merged plate was already imaged and you later want to image only some of the press plates again.

- **Go to Job**: When the Pilot is in Container mode and when the selected press plate is part of a Job, select this option to filter the Merged Plates view to only those of that Job.
- **Go to File**: Goes to Files view and selects the LEN file of the selected press plate.
• **Show in Press Plates**: Shows the selected press plate in Press Plates view.

• **View**: Opens the press plate's LEN file in the Automation Engine Viewer. This will require the LEN file to have prepared view data (learn more in *Working with RIP data in the AE Viewer*).

**Note**: If you wish to open LEN files in the DFS "View" application (aka "Esko Bitmap Viewer", Windows only), then choose 'Go to File' and double-click the file there. This will open the file in the application that you first instructed your local computer to 'open with'.

• **New Task**: Use this tool to select a task ticket to launch on the LEN file of the selected press plate. This is for example how you can submit the selected press plate(s) back to the plate merger but use different options than those used originally.

### 2.6. CTP Queues

The **CTP Queues** view shows the queues of configured **CTP Flexo Devices**.

In case of a **CDI Imager**, it shows what is present in the "Exposer" queue of that CDI. The "Exposer" is the DFS/Grapholas application where you manage the queue and start the actual exposing. This view automatically updates to show new or changed entries.

You can see these queues in a time line or in a list view mode.

![Automation Engine Pilot](image)

**Note**: Go to **Tools > CTP Queues** to open this view in a separate window. To avoid seeing only job specific entries, switch to Container view or Jobs Overview before doing this.

**Note**: When a CDI Imager is offline, an icon appears next to its name: 🌒
• **Time Line View Mode**

  Each queue entry is visualized by a rectangle which length corresponds with the estimated duration to expose that job. Its default color is blue.

  **Attention:** CDI's with a Grapholas version 12 up to v14.0 offer a more limited interface with Automation Engine. The estimated expose time is then not accurate; it will often be too short.

  • When an entry is being exposed, that entry moves gradually to the left of the red line.
  • Use the slider to increase or decrease the size of the queue entries.

  **Tip:** Click on the slider to select it. This is indicated by the blue bar: . At this point you can use the arrow keys to increase or decrease the entries.

  • Select an entry to see its details on the right. You can use the left-right arrows to navigate through the queue and change the selection.
  • When your Pilot is in **Last used Job** mode, all the entries that relate to a different job are greyed out and can not be selected. Switch to Containers view to make sure you can select any entry.

• **List View Mode.**

  This view makes it easier to read an entry's name or plate type. You can also click the column headers to sort by that attribute.

  **Note:** When your Pilot is in **Last used Job** mode, this list only shows entries that belong to the selected Job.

### Conditional Coloring

Coloring the entries helps to get a quicker understanding of the queue's content. You could for example assign a color per plate type or per resolution or per urgency (based on due date).

Follow these steps:

• Right-click the name of any of the CDI devices and choose **Conditional Coloring**.

• **Add** one or more rules.

• Rules are executed top to bottom. Use **Move Up / Down** to change their order.

This conditional coloring is applied on all devices and is saved per user, so different users can use different coloring rules.

### Managing Queue Entries

**Tip:** Selections that you make remain active when you switch the / view modes. An example: In the **List view mode**, sort per column and then make a multiple selection. Then switch to the **Time Line view mode** where the selection is kept and then move the selected entries to the front of the queue.
Tip: You can also execute below mentioned actions on selections that you made with the filter.

- **Deleting queue entries.** Select and press **Delete** (or right-click and choose **Delete**) to remove entries from a queue. You will be asked to confirm. In the Merged Plates view, you can see how the merged plate still exists but has changed its status to ‘Cancelled’.

- **Moving an entry to a different position in the queue.** You can re-arrange the queue by using drag and drop, even on multiple selected entries.

- **Moving an entry to another queue.** When a CDI needs to go in maintenance, or when you manually want to balance the load, you can drag and drop one or multiple queue entries into the queue of another CDI device.

  Because a device is never exactly the same, the merged plate that changes device will always be re-calculated. You will always get feedback and will be asked to confirm.

  - When the entry cannot be exposed on the other CDI, you get a warning and the entry will stay in its original queue.
  - When the entry can be exposed on the other CDI, you get an information dialog and the entry will eventually show up at the back of that other queue.

  **Note:** This is what happens in detail: All device specific data is removed from the layout XML file and the output workflow of the merge queue (where it was originally made) is launched again. This re-creates a merged plate and that LEN file is then submitted to the new device where it appears as a new entry at the back of its queue.

- **Reconsider Merged Plates.**

  This resubmits all the press plates of this entry back to the plate merger and it removes the entry from this CDI “Exposer” queue. It also removes the entry for that merged plate in the *Merged Plates view*.

  This feature is interesting when you think that you can get a better fill percentage on this merged plate when some of the new (smaller) press plates that recently arrived in the merge queue could also become part of the layout.
3. CDI and LEN related Tasks

**Note:** In a standalone setup of Device Manager, several of these tasks are not available.

3.1. Add Margins to LEN file task

**Note:** The CDI platemaking workflow, its terminology and the Plate Merger are described in the *introduction* of this chapter.

**Concept**

This task adds margins to a LEN or LENX digital film file. These extra margins can so help plate mounting or plate re-mounting (PlatePatcher workflow).

Using this task can also make sure that there is (just) enough space between press plates LEN/LENX files on a *merged plate*. However, that can also be done by using the option *"Press Plate Margins"* in the *merge settings of a Merge Queue*. That way, you are not changing the actual press plate LEN/LENX files but only adding these extra margins in the calculation of the layout.

**Note:** When you want to add extra margins to a merged plate, then use the plate merger’s option to *add margins to the merged plate*.

**Settings**

Enter a value per side or use SmartNames to specify the value(s). SmartNames can help automate the fact that your different printers may want different plate margins.

**Note:** You can also enter negative values. That side will then be cropped with that distance. You can however crop the file automatically with the *Crop LEN file task*.

**Caution:** Some Step & Repeat tasks (and also Plato) offer an option to *"Include CAD info for Digital Flexo Suite"* in the PDFPLA file. This is used to include the technical inks data in the metadata of the output file. In the Bitmap Viewer and in the DFS Viewer, you can see these as layers “Pluto Cut” and or “Cut/Cr ease line registration”. A LEN file made from that PDFPLA file will then have that information embedded. However, launching the *Add Margins to LEN file* task or the *Crop LEN file* task on such a LEN file will remove that metadata (layers) and end with a warning. Mind that this does not remove the metadata / layer named *"Staggered Cut"*. 

Note:
• If you want to view your LEN files after adding margins (for quality control), you can use:
  • the Grapholas Viewer,
  • the Bitmap Viewer,
  • the Prepare for Viewer task then the Automation Engine Viewer.

• For LENX files, you can use:
  • the Grapholas Viewer,
  • the Bitmap Viewer.

3.2. Crop LEN File task

Note: The CDI platemaking workflow, its terminology and the Plate Merger are described in the introduction of this chapter.

Concept
This task serves to crop a LEN or LENX digital film file to the bounding box of all visible objects combined. By default, the task crops the LEN/LENX file to first pixel of that separation.

However, when there is a staggered cut line present in the file, the task crops to the bounding box of that line (even if there are pixels outside the cut line). An example:
Note: A typical workflow might be to first use this task to crop the LEN/LENX files and then use the Add Margins to LEN file task to add margins again (and maybe not on all 4 sides).

Caution: Some Step & Repeat tasks (and also Plato) offer an option to "Include CAD info for Digital Flexo Suite" in the PDFPLA file. This is used to include the technical inks data in the metadata of the output file. In the Bitmap Viewer and in the DFS Viewer, you can see these as layers “Plato Cut” and or “Cut/Crease line registration”. A LEN file made from that PDFPLA file will then have that information embedded. However, launching the Add Margins to LEN file task or the Crop LEN file task on such a LEN file will remove that metadata (layers) and end with a warning. Mind that this does not remove the metadata / layer named “Staggered Cut”.

Note:
- If you want to view your LEN files after cropping (for quality control), you can use:
  - the Grapholas Viewer,
  - the Bitmap Viewer,
  - the Prepare for Viewer task then the Automation Engine Viewer.
- For LENX files, you can use:
  - the Grapholas Viewer,
  - the Bitmap Viewer.

Task Settings

Bleed:
- The bounding box of all pixels found in a separation is extended with this bleed. The task then crops to that enlarged area.
- If there is a staggered cut line, the task crops to the area of the bounding box of the cut line, enlarged with this bleed.

3.3. Submit to Plate Merger task

Note: The CDI platemaking workflow, its terminology and the Plate Merger are described in the introduction of this chapter.

Concept

This task serves to submit Press Plates (LEN files) to a Merge Queue of the Plate Merger.
Press plates that you submit to a merge queue can be merged together on a same merged plate,
- when they have the same value for plate type, resolution, imaging technology and cutting workflow,
- and when they have the same value for custom Grouping Keys (that you can set up in the Configure tool).
Attention: The plate merger requires that the XMP metadata of the input LEN files contain information on `hsize`, `vsize` and `resolution`. This is the case for LEN files created by Imaging Engine or FlexRip version 14 or higher.

In a workflow, you can add this task after the RIP’ing task. See this example, where the LEN files are first cropped and where also view files are created for the Automation Engine Viewer:

**Tab ‘General’**

- **Merge Queue**: Select or name one of the merge queues that you defined in the Plate Merger view.
  
  **Note**: When a ▲ warning sign ❌ appears left of the selected name, hover your cursor over the icon to read more about the problem.

- **Rotation**: Define how the press plate may be rotated on the merged plate:
  
  - **Set by Merge Queue**: This leaves the decision to the merge queue, so allowing it more variants in its calculation of the layout with the best fill percentage.
  
  - **Force 0**: It will not be rotated, it will stay in the orientation as shown in the press plate preview and as shown in the Automation Engine Viewer.
  
  - **Force 90**: It will be rotated 90 degrees clockwise.

  - **Select SmartName**: To find out what the parameter value is of an entry in a drop-down list (or of an icon), select that entry from the list, then right-click that setting and choose **Copy Parameter Value**. Then paste that value in any input field. You then can see what the SmartName should resolve to.

  **Note**: A rotation on the merged plate is never done on the input press plate LEN file. This is only done when the merged plate LEN file is created (during the **Create Merged Plate task**).

- **Imaging Technology**: Select the imaging technology that these press plates need to be imaged with. This field automatically serves as a grouping key.

  **Note**: This list shows all available technologies on all configured Devices (DFS Merger’s). It is automatically updated. Learn more about these technologies in the documentation of **PlatePrep**.

  **Note**: The technologies ‘Speed’ and ‘Speed UV’ require Grapholas v19.
• **Due Date:** When considering the layout of a merged plate, the merger's main criterion is the fill percentage (learn more in *Plate Merger* on page 19). However, when you here add a due date, the merger also takes this time into account to make sure you that you have these press plates in time on the CDI (as part of a merged plate).

**Note:** The effect of setting a due date can be compared to the *Force Out* option in the merge queue, but then as an automatic step at the specified time.

• **None.**
• **Time setting:** Select or specify an absolute or relative time.
• **Job due date:** The due date is taken form the due date of the *Automation Engine Job* that the LEN files belong to (residing in its job folder).

**Note:** When the job due date changes, the entries in the merge queue that were submitted with the list option "Job due date" will adapt and reflect this new date. This will only be done if the press plates are still in the Merge Queues. This will not be done if the press plates were already send to the CTP queues on the CDI.

**Note:** When the due date you want is the one from the job, then do not use the SmartName version ; use this item in the drop down list to avoid any error due to formatting problems.

• **Select SmartName.**

**Note:** If you are using a SmartName for date or time, the resulting format needs to be compliant with ISO 8601 (YYYY-MM-DDThh:mm:ssTZD). For example: 2014-07-28T12:00:00+01:00.

**Attention:** When you relaunch a Submit to Plate Merger task that had a due date defined on an absolute time, it is then possible that that due date has already passed. This will have the effect that the press plates, the moment they arrive the merge queue, already have the status 'forced out', and therefor quickly disappear again from that queue.

• **Label:** The text you enter here is placed on the merged plate, around each press plate. The text label is placed on the chosen position, centrally, uses the font "Arial" and the size is 4 mm. If there was not yet a margin of 4 mm, it will be created automatically on the side where the label is placed.

**Note:** If either the label text or position is based on SmartNames that cannot be resolved for one input file, the task will fail for all input files.

**Note:** Before AE v18.1.1, adding a label added a margin of 4 mm on all 4 sides of the press plate.

• **Allow different devices and rotations:**
  • When this option is not selected, all press plates that you here submit will end up on the same device and have the same rotation.
• When this option is selected, they can end up on different devices and have different rotations. This can result in layouts with less waste.

• **Apply cutting flow:**
  Select this option when the merged plate will be cut on a Kongsberg cutting table.
  • When that Kongsberg table was also added as a Device, then the workflow status will include the status of the cutting on that table. The status 'Exposing Done' will change to '(Cut) Done' once that signal comes back from the KB table.
  • When that Kongsberg table was not added as a device, the required cutting files will still be created but you have to adapt your workflow so that they are provided to the table. Learn more below on setting up this cutting workflow in the Configure tool (Plate Merger).

  This off-line link means that the CDI workflow can not be aware of the cutting status. It therefore already sets the state of the (merged) Plate to 'Cut = Done' right after the exposing is done on the CTP Flexo.

  **Note:** This option is not available when your setup is a standalone **Device Manager**. Contact Esko to learn how to extend this functionality.

• **Cutting Flow.** Select the type of cutting from the drop down list. This field automatically serves as a grouping key.

  **Note:** The .xwf files in this list are those on the central resource folder on the Automation Engine Server. This is the folder where the DFS merger writes .xwf files when it is in "AE" mode.

The **Cutting Flow** that you define here will later be part of the XML file that, once the CDI plate is made, can automatically be sent to the cutting table. Learn more in the **Configure tool**, where to define that workflow to launch (in the tab **Setup**) and where to define any reporting related to cutting (in the tab **Reporting**).

**Tip:** To achieve a better fill rate, the Plate Merger by default merges press plates with and without a cutting flow. However, the plate merger will not merge press plates that ask for a different cutting flow.

In the special case you never want to mix press plates with and without a cutting flow, you can use a grouping key to prevent this:

1. In **Pilot > Configure > Plate Merger > (Setup)**, pick a custom field, give it the name (for example "Manual Cutting") and select the option "Use as grouping key".
2. Then, when submitting press plates that may **not** be cut on a cutting table, put the value for this custom field ("Manual Cutting") on "Yes".

• **Job Info:** This option is only available when your setup is a standalone **Device Manager**. Consider using SmartNames to pick up job information that came from your MIS.

**Tab 'Custom Fields'**

• **Custom Field 1 to 5:** The name of these 5 custom fields is set up in the **Configure tool**. Their name becomes the name of the columns in several of the CDI related Views. You can then also use their values when filtering. A setting in the Configure tool decides whether they will also be used as grouping keys.
3.4. Create Merged Plate task

**Note:** The CDI platemaking workflow, its terminology and the Plate Merger are described in the *introduction* of this chapter.

**Concept**

As mentioned in *Main steps in setting up a CDI workflow* and in *the Plate Merger View*, this task is the first step of the workflow that the merge queue launches when having created a layout. The input file of this task is the XML file with all the details of that layout. The task creates a LEN file of that layout. It also creates previews and other files that are all written in the *Output Folder defined in the Configure tool* (where you can also define when these files need to be cleaned up).

**Note:** Creating a large bitmap file is an intensive task for your Automation Engine server. You will also notice that this task takes longer when it first needs to rotate press plates before placing them on the layout.

By default, the **CDI Job Name** is the name of the input XML file. Use SmartNames to change it. This name will be used as the name for the job in the CDI's **Exposer** queue.

The output of this task is also an XML file. This one refers to the LEN file and other related files it created.

When this was requested for its press plates in their *Submit to Plate Merger task*, this task also creates the cutting instruction. This cutting file is also referred to in this task’s output XML file. Learn more about how and when this cutting information gets to the cutting table *here*.

**Settings**

- **CDI Job Name.** Once the output file is submitted to the CDI, this is the name of the entry in the CDI "Exposer" queue. By default, the SmartName [File] will make the CDI job name equal to the name of the XML layout file that the merger created: `<name of AE server>_<date>-<time>_<sequential number>_cdi`.

3.5. Submit to Flexo CTP Device task

**Note:** Until AE v18.1.1, this task was named 'Submit to CDI'. Tickets that were made in those older versions will still name this task like that.

**Note:** The CDI platemaking workflow, its terminology and the Plate Merger are described in the *introduction* of this chapter.

**Concept**
This task submits a merged plate to a **CDI "Exposer" Queue**. The input file for this task is not a LEN file but needs to be the output XML created by the **Create Merged Plate task**.

As mentioned in **Main steps in setting up a CDI workflow** and in the **Plate Merger View**, this task is the last step in the workflow that a merge queue launches when having created a layout.

**Note:** This task type can not be re-launched. To resubmit a merged plate to the CDI queue for which it is intended, use the function **Resubmit Merged Plate** in the Merged Plates view.

In the Pilot, the task's **Details** pane offers a link to an XML report file. Learn more about what you can do with report files in **Reporting to Business Systems** on page 9.
4. Using the DFS Merger in AE mode

Concept

This page illustrates the semiautomatic workflow that we introduced in the intro of this chapter.

Configuration

To make a DFS Merger see the merge queues on Automation Engine, the AE server needs to be configured as "Workflow Server".

Note: The communication between a DFS Merger and Automation Engine happens via JDF/JMF.

Follow these steps to link a DFS Merger to an Automation Engine server:

1. In the DFS Merger, add the name of your Automation Engine server in Options > Preferences > Merge tab > Workflow Server.
2. Click OK.
3. Test the connection by loading some images from a merge queue (see below).

Workflow Steps

1. Click the button. The title bar indicates you are now working in "AE Manual" mode. A green background color also reminds you of this different mode.

Note: To change the mode back to (local) "File Mode", simply click AE again.

Note: This button does not appear when there was a problem connecting to Automation Engine when starting up the DFS Merger.

2. Click to load images. A dialog opens that shows the AE merge queue(s) and their contents:
Note: Locked items are shown in pink (for example images that you already loaded or image sets being used in another DFS Merger).

- **Queue**: This dialog only shows the merge queues that contain images (press plates).

  Note: Press plates that in their merge queue have the status "Rejected" are not shown in this dialog.

- **Image sets**: Sets are groups of images that can be exposed together on the same plate, typically because they have all their grouping keys in common. The columns already show some attributes they have in common.

  Note: Test strips are not shown in this dialog. They do appear as a Loaded Image after you clicked Load Selected Image Set. Learn more below.

- **Images**: Shows which images are in the selected image set.

- **Filter**: When you type a (part of an) image name in this field and click, you will only see the image sets (middle pane) or merge queues (left pane) that contain images with that (part of their) name. To remove the filter, empty the input field and click again.

- **Load Selected Image Set**: Click this button to add all images of the selected image set to the list of Loaded Images in the DFS Merger.

  The attributes that these images share (as shown in the columns in Image sets) are enforced into the DFS Merger. Also the margins and rotations that were requested on Automation Engine are communicated to the DFS merger (the margins can here still be overruled).

  Note: When your Automation Engine has a license for automatic merging by the merge queues, clicking "Load Selected Image Set" also sends a signal to the selected merge queue: To prevent any further automatic merging, this queue is paused. This way, that merge queue only stays available for manual merging, until one of these actions is taken:

  - "Load Selected Image Set" was clicked for an image set of another merge queue.
  - The DFS Merger is no longer in "AE Manual" mode.
  - The DFS Merger is closed.
Note: When the image set contains a test strip (as requested in the merge queue's configuration), it will also appear in the list of Loaded Images.

- To easily recognize it, its thumbnail will be marked with a letter "T".

- You can manually place the test strip as any other image.
- When using CTRL-A (Auto Arrange Images), the test strip will be placed bottom left and no other images will be placed on top of it, against that left side of the plate.

- When using CTRL-H (Auto Arrange New Images), the merger will try to place the test strip in the same place it was placed on the previous plate layout.

Note: Click 🔄 to check if new images arrived in the image set that you loaded.

3. Now, in the same way as you would do with local images, create a layout with the loaded images.

Note: When you have a partial plate that still has the full circumference (vertical size), you can use that plate by first changing the plate's horizontal size.

4. When you are finished creating the plate layout and ready to send this layout to the CDI "Exposer" queue, click 🎨 Exposer. You will be asked to fill in a name of this job.

Attention: The value you here type in can appear as the job name in the CDI "Exposer" queue, but only if you also create a specific SmartName and use that SmartName in the Create Merged Plate task. Learn more in Creating the SmartName for the CDI Job Name on page 63.

In this "AE" mode, when you click 🎨 Exposer (and confirm a name for the job),

- on Automation Engine, the merge queue of the placed images starts its output workflow on this manually created layout.
- In the DFS Merger, the used images disappear from the list of Loaded Images and also disappear from the "Select an image set" dialog, because they were also removed from their merge queue.
5. On Automation Engine, the Tasks view shows the output workflow. When that workflow is finished, the new job appears in the CDI "Exposer" Queue that the layout was made for.

4.1. Creating the SmartName for the CDI Job Name

As mentioned in the page describing the DFS Merger in "AE Manual" mode, the name that you type in after clicking can be picked up by a SmartName so that it appears as the name of the job in the CDI "Exposer" queue.

Follow these steps:

1. Create the SmartName as shown in this screenshot:

![SmartName Creation Screenshot](image)

Learn more about creating such SmartNames in XPath Query SmartNames.

2. Use this SmartName in the Create Merged Plate task that is part of the workflow launched by the merge queue.

3. Test.
**Note:** When your CDI plate production is mixing the *automatic merger workflow* with this *DFS manual merger workflow*, you can create and use this conditional SmartName:

This one checks whether the CDI job name is part of the (automatic merger's) XML file or if it was typed in by a DFS user (if so, it uses the one we created above).
5. FAQs

**Can I send the information that I see in the Views to my MIS?**
Yes, workflows can send that information to your MIS. Also, your MIS itself can get that info on demand.
See the reporting options in *Plate Merger Configuration* on page 26.

**What to do if a CDI plate is damaged after exposing?**

- **When you want to re-make the exact same CDI plate:**
  Go to the Merged Plates view, select the item and press "Resubmit Merged Plate". Learn more [here](#).

- **When you only need to remake specific parts of that CDI plate** (specific press plates):
  Go to the Merged Plates view, double click the item to zoom in and see its press plates. Select the wanted press plates, right-click and choose *Resubmit Press Plates*. Learn more [here](#). Alternatively, go to Press Plates view, select the press plates there, right-click and choose *Resubmit Press Plates*.
  The resubmitted press plates are now back in the Merge Queue. Use "Force Out" if they are urgent.

- **When you want to re-expose all the press plates** that were on the damaged merged plate, but it **does not have to be the same layout:**
  Then go to the Merged Plates view, select the merged plate, right-click and choose *Resubmit Press Plates*.
  The press plates are now back in the Merge Queue. Use "Force Out" if they are urgent.
6. XML technical details

This section adds detailed technical information to help you understand and interpret some of the XML files in this workflow.

6.1. Interpreting reporting XMLs

Reporting XMLs were introduced on this page about the plate merger configuration.

Content wise, there are basically 3 types:

- an XML describing the merged plate that was queued to a CDI.
- an XML describing the merged plate that was exposed on a CDI.
- an XML describing, from a job order point of view, details about the current state of the press plates of that job.

Their main content and structure is easy to understand. Below we only illustrate the terms that require some explanation.

Attention: Be aware that the terminology in these XMLs uses the vocabulary of the DFS, i.e. a press plate is referred to as an image and a merged plate as a plate.

The root element of these XMLs is <FlexoPlateReport>.

Terms used when describing the XML element <Plate>

The XML element Plate refers to a merged plate that is processed on the CDI.

Below described statuses are those at the moment the XML report was created.

- <ExposeState>: Possible values are:
  - MP:QUEUED: The merged plate resides in the "Exposer" queue of a CDI.
  - MP:EXPOSING: The merged plate is being exposed on the CDI.
  - MP:EXP: The merged plate has been successfully exposed on the CDI.
  - MP:EXP_CANCELED: The merged plate entry in the "Exposer" queue has been removed before exposing.
  - MP:EXP_ERROR: The merged plate was not successfully exposed on the CDI or no information could be obtained for the merged plate when consulting the DFS.
  - MP:RECONSIDERED: The merged plate has been reconsidered. It therefore no longer exists.

- <CuttingState>: Possible values are:
  - STC10:WAITING: The merged plate resides in the queue of an iPC (Kongsberg table).
  - STC30::DONE_OK: The merged plate has been successfully cut on a Kongsberg table.
• **STC50: DONE_ERROR**: The merged plate was not successfully cut on a Kongsberg table.

**Terms used when describing the XML element <Image>**

The XML Element `<Image>` refers to a Press Plate.

• **<State>**: Possible values are:
  • **ST10: WAITING**: The press plate is part of a merged plate that resides in the "Exposer" queue of a CDI.
  • **ST20: EXPOSING**: The press plate is part of a merged plate that is being exposed on the CDI.
  • **ST30: EXP_OK**: The press plate is part of a merged plate that has been successfully exposed on a CDI.
  • **ST50: EXP_ERROR**: The press plate is part of a merged plate that has not been successfully exposed on a CDI.
  • **ST80: EXP_CANCELED**: The press plate is part of a merged plate that has been removed from the "Exposer" queue of a CDI.

• **<Plate Id>**: The 3rd type of XML in the list above, the one that describes all the press plates ('images') of a job, also describes on which merged plates ('plates') they were exposed on.

For each <image>, its <PlateId> text value refers to the <Plate> element, with that same value for its attribute "id=".

**Attention**: When you move a job from one CDI device queue to the another CDI device queue, it will get a new plate ID. Systems that interpret the "Submit to CDI" XML reports will then need to listen to that new ID; there will be no more reporting info related to the old ID.

An example:

```
Plate id="587e-1458-0301" requeueId="587e-1414-1501"
```

"id" is the new one, "requeueId" was the original plate ID before it was moved to another queue.

• **<IdOnPlate>**: This is a unique identifier for the press plate. In the views Press Plates and Press Plate Sets, you can see (and filter on them) by using the column Press Plate Id.